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Abstract 
This document is aimed at students who have no (or very little) experience of 
word-processing. You will learn how to create and save a simple Microsoft 
Word for Windows 2003 document.  Microsoft Word for Windows 2003 is a 
very powerful word processor so in this document you will only be introduced 
to some of what it can do.  However, you may then refer to other training 
material in order to improve your skills. 
 
The material is designed for use on Birkbeck Central Computing Services 
(CCS) workstations. If you are using the material for self-training on CCS 
workstations then you will need a CCS username and password. 
 
Prerequisites 
No prior experience of computers is required.  However, it will help if you are 
familiar with using a mouse and PC keyboard, logging in and using a 
Windows desktop.  At the back of this document, there are instructions for 
using the mouse.  There is also a plan and a description of the PC keyboard. 
 
For more information on getting started with computers please refer to CCS 
document 3.38 ‘Getting Started on CCS workstations’, available from CCS 
Help Desk.  
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About this Document 

 Words that you type or choose are in bold type, e.g. Choose Programs 
from the Start menu. 

 Keys that you press are shown in bold e.g. press Alt. 
 Press KEY1 + KEY2 means press both keys together e.g. press Ctrl + Z 
 Press KEY1, KEY2 means press each key consecutively e.g. press A, B. 
 General guidelines on how to perform a task are indicated by bulleted lists 

using the  symbol. Note that these are not tasks for you to perform now 
they are advice for you to follow later when you need to work things out for 
yourself.  

 Exercises for you to practice as you work through the notes are labelled 
Exercise, e.g. Exercise 1 Logging on. To complete the exercise you 
should work through the steps marked by round bullets (•). 

 
 

ii Birkbeck College Central Computing Services 



Getting Started with Word 2003 Doc. 5.132 Ver 1 

1 Introduction 
This document explains how to use the word-processing package Microsoft 
Word for Windows 2003 to create a simple document. You will learn: 

 How to login and start Word 
 How to enter, edit and format text 
 How to save your work and exit from Word 
 How to look after your files on floppy disk 
 How to go back to your file and do more editing 
 How to spell check your document. 

 
You will need a CCS username and password. New students should receive 
this from CCS within a few days of completing their enrolment. If you are 
attending a CCS workshop then the instructor will lend you a temporary one 
for the duration of the workshop. 

2 Logging on 
If you have not already logged on, please log on now. 

Exercise 1 Logging on 
• Windows 2000 saves power by turning the monitor off when it is not in use, 

so if the screen is blank press any key to turn it on. If nothing appears after a 
few seconds, check that the monitor power switch has a light next to it and 
switch on the power if necessary. 

• Before you log on to the workstation Windows will display a small box with 
the title Welcome to Windows at the top  

• Press CTRL+Alt+Delete (+ means press all the keys gently and quickly 
together).  

• You will see a warning to unauthorised users. Press the ENTER key - (If 
you know how to use the mouse then you can click on O.K.) 

• A box appears, asking you to provide a username and password. Type 
your username in the box labelled User name 

• Press the. TAB key (see left). This is located on the left of the keyboard, 
next to the Q. The cursor will move to the box labelled Password (If you 
know how to use the mouse then you can click in the box) 

• Type your password in the box labelled Password.  
• Check that CCSACADEMIC is displayed in the box labelled Log on To. 
• Press the ENTER key  (or click on O.K) 
 
There is no need to log off yet - but when you have finished using CCS 
workstations, you must log off to prevent unauthorised users from 
accessing the system. 
 

 To log off using the mouse double click on the LOG OFF icon 
on the desk top  

 To log off using the keyboard press CTRL + Esc, U, Enter 
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3 Starting Microsoft Word for Windows 2003  
On CCS systems we use the Start Menu to start Microsoft Word for Windows 
2003.  However, if you normally work on a system with a Microsoft Word for 
Windows 2003 on the desktop then you can start it by double-clicking on the 
Microsoft Word for Windows icon. 
 

Exercise 2 Start Word from the Program menu 
• Click on the Start button at the left hand end of the task bar (or 

press Ctrl + Esc). 
• When the start menu appears click on Programs (or press P) 
• Click on the Microsoft Word icon (or move to it using the down arrow 

cursor key & press Enter) 
 
After a few seconds Microsoft Word for Windows 2003 will start (Figure 3-1 
Word 2003 WindowFigure 3-1). When you start a program, it opens in its own 
window.  Microsoft Word for Windows 2003 window has similar features to 
other programme windows that you may have come across, such as Web 
browsers or email programs.  We will use most of these features at some 
stage; here is a brief summary for reference. 

 The Title Bar at the top of the screen tells you the name of the program, 
and the name of the document. When you start with a new document it 
has no name, it is called document1, document2 etc. 

 Beneath the Title Bar, the Menu Bar contains the names of menus. A 
menu is a list of items. You choose items from the menu. The items are 
functions such as printing your document. 

 The Tool Bars beneath the menu bar display small icons called buttons. 
Buttons provide short cuts to functions that are also available on the 
menus. 

 In the top right corner of the window, resizing buttons are used for 
resizing the window.  Do not click on the , as this will close Microsoft 
Word for Windows 2003. 

 In the bottom left corner of the document, the View Toolbar allows you to 
view your document in different ways.  For most purposes Print Layout 
view is used so you probably will not need to use this.  

 The scroll bars allow you to move up and down or left to right. The 
vertical scroll bar (up and down) is located on the right hand side of the 
document.  The horizontal scroll bar (left to right) is located at the bottom 
of the document. 

 The status bar beneath the horizontal scroll bar tells you how many pages 
there are in the document, and where you are in the document, for 
example 2/10 means you are on the second page of a ten-page document. 

 The insertion point appears as a blinking black vertical line. It shows you 
where the text that you type will appear.  As you type, the insertion point 
moves to the right.   
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Figure 3-1 Word 2003 Window 
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4 Entering text in a document 
When you start Microsoft Word for Windows 2003, you may see the Office 
Assistant.  If the paperclip symbol annoys you, press ALT + H to drop down 
the Help menu.  Then press O to hide the office assistant.    

Exercise 3 Enter text into a new document 
• If the Microsoft Word for Windows 2003 window does not occupy 

the full screen click on the Maximise button (see right) or press Alt 
+ space + X.  

• Type the text shown below.  If you make a mistake, press the BACKSPACE 
key ← to delete it, and then type the correct text.  When you get to the end of 
a line, just carry on typing - Word will automatically move to the next line for 
you.  This is known as word wrapping.  Do not worry if the line-endings do 
not correspond with those below. 

 
With flowers, you first decide what kind you want to grow, and then whittle it 
down to what kind you can grow in the space.  But never waste your energy trying 
to grow a thing.  If it wants to die, have the decency to let it die, and then, when 
you are totally sure that life is extinct, go out and buy yourself some other kind 
which will like you and your soil and live happily with you ever after. 

 
Note that what you type is always inserted in front of a blinking black line - this is 
known as the insertion point, and shows you where the text that you type will 
appear.  As you type, the insertion point moves to the right.  
 
You will see that the mouse pointer has changed shape. It is now a bar 
shaped I, rather than an arrow. You can insert text into a document by moving 
the mouse pointer to the place in the text where you want the text inserted, and 
clicking the left button once.  This will move the insertion point to this spot, and 
whatever you type will then be inserted in front of the insertion point.  You can 
also reposition the insertion point by using the cursor keys.  These are the four 
keys located to the bottom right of the main QWERTY keyboard, labelled with 
up, down, left and right arrows. 
 

Exercise 4 Inserting text into existing text 
• Insert the following sentence before the last sentence (If it wants to die...) in 

the practice text: 
 

There is no sense or dignity in fighting the inclinations of a plant. 
 
You will find that the rest of the text moves to make space for the sentence. 
Check the spacing before and after the new text that you typed.  To add a 
space, click where you want the space inserted then press the SPACEBAR. 
 
• Add the following phrase after the first two words in the text (With 

flowers,...): 
 

as with all other departments of the garden, 
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Let us add another section to our practice text, and this time we do not want 
Word to word-wrap the text, because we only want short lines.  We use the 

Enter key ↵ to force the start of a new line, and to create blank lines.  
 
• Position the cursor at the end of the text 
• Press the Enter key twice to create two blank lines 
• Type the following text 
 

Plants for Butterflies 
 
Buddleia (especially for peacocks, red admirals, painted ladies, and large moths). 
Wild yellow bedstraw for small blues. 
Sedum for anything but commas. 
Golden Rod for tortoiseshells and red admirals. 

5 Editing Text 

5.1 Deleting Text 
You may always press Backspace to delete text.  This is, however, laborious 
if you want to delete much text, and there are more convenient ways of doing 
it.   
To delete a word, for example, you can simply double-click on it (i.e. point at 
the word, then press the left mouse button twice, lightly and quickly), and then 
press Backspace once.   
If you prefer to not to use the mouse then move the cursor to the start of the 
word using the cursor keys, hold down the shift key, and move the cursor to 
the end of the word. 
 

Exercise 5 Deleting and Replacing Text 
• Delete the word especially after the word Buddleia, then the word large in 

the same sentence. 

5.2 Selecting text 
When you double-clicked on a word, you should have noticed that it became 
highlighted.  This is known as selecting the word.  There are many other ways 
of selecting text - you can select whole blocks of text as well as individual 
words.   Note for future reference that there are many other contexts in which 
you need to select some text, apart from deletion, before doing something 
further with it - e.g. to change its appearance, by italicising it or changing the 
font. 
  
The easiest way to select a block of text is: 
 

 Move the cursor to the front of a word, using either the mouse or the 
cursor keys. 

 Press and hold down the SHIFT key ⇑  
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 Move the cursor to the end of the text using the arrow keys, or click at the 
end of the text with the mouse 

 Release the SHIFT key 
 
The block of text will become highlighted, indicating that it has been selected.  
To deselect text either click the mouse outside the selected area or press any 
cursor key. 
 
Now select a block of text to do the following tasks: 

Exercise 6 Selecting Text 
• Select the phrase or dignity in the third sentence of the first paragraph 

(There is no sense or dignity...), and press BACKSPACE to delete the 
selected phrase (also known as the selection). 

• Now select a whole sentence - the fourth sentence in the first paragraph (If 
it wants to die...). 

• Delete the selected sentence 
 
It is very easy to replace text (i.e. delete some text and type something in 
place of it).  Just select the text that you want to delete, and then start typing 
the text that is to replace it.  The selected text will disappear, and your new 
text will be inserted in its place.   
 
• Replace red admirals in the line beginning Buddleia with tortoiseshells.   
 
Note, however, that it is quite possible to replace text by mistake!  If you start 
doing something else while a piece of text is still selected, you may find that 
text replaced by something that you had not intended.  So make sure that you 
deselect text before moving on to do something else (you will, however, find 
out later how to undo something which you did not mean to do!).  

5.3 Changing the Appearance of your Text 
You can change the appearance of your text by, for example, emboldening 
words, or putting them in italics.  This is known as formatting, and you can do 
it either with the buttons at the top of the screen or by using short cut keys.   
Let us introduce buttons, which are used extensively in Windows programs. 
 
There are two rows of buttons at the top of the screen, and we refer to these 
as toolbars, (as below)  

Figure 5-1 Toolbar 
 

 
 

 The top row is called the standard toolbar, for performing general tasks 
such as printing 

 The bottom row is called the formatting toolbar. 
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 If you cannot see the toolbar, click on the View menu and then click on 
Toolbars.  A tick  should appear next to the toolbar name. If it does not 
then click on the toolbar name so that the tick appears. 

 If you cannot see all the buttons click on the ‘more buttons’ symbol >> at 
the end of the toolbar and choose “Show buttons on two rows” 

 
Exercise 7 Finding out what the buttons are for 

• Move the mouse pointer to a button (do not click the mouse button!). 
The pointer becomes an arrow again, and you will find that a 
description of what the button does will hover near the pointer (you may 
have to wait a second for this).  It is therefore referred to as hover help.  

 
Now let us use the formatting toolbar to italicise some of the words in the 
practice text: 
 

Exercise 8 Formatting text 
• Select the word want (what kind you want to grow...) in the first sentence 

(the easiest method is to double-click on it). 
• Point to the button marked with an italic I (one of the buttons marked BIU - 

see margin) and click - the word will become italicised, and you will see that 
the I button appears to have become depressed. (Or press Ctrl + I) 

 
The word will still be selected - to deselect it, click somewhere else in the text 
(the I button will revert to normal, because the insertion point is no longer on 
italicised text). 
 
• Now italicise the word can in the same sentence (what kind you can 

grow...), and trying in the following sentence (starting But never waste...) 
• Italicise the words Buddleia and Sedum, in the last section 
 
Let us make bold the heading Plants for Butterflies:   
 
• There is an easy way to select a whole line!  Put the mouse pointer in the 

margin to the left of the heading, and move it around until the pointer 
changes into a white arrow.  Then click, and the line will become selected. 
To do this without using the mouse, position the cursor at the beginning of 
the line, hold down the Shift key, and press the End key (located to the top 
right of the QWERTY keyboard) 

• Click on the button marked with a big B (next to the italic button).  When 
you remove the highlight (by clicking elsewhere), you will see that the 
heading has become emboldened. (Or press Ctrl + B) 
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5.4 Recovering from mistakes 
If you do something by mistake, there is a simple way of undoing it.  Click on 
the Undo button, which is in the middle of the standard toolbar (see margin). 
(Or press Ctrl +Z)  This will undo the most recent task that you performed.  If 
you find that you have undone something you did not want undone, then 
press the Redo button (or press Ctrl + Y).   
 

Exercise 9 Undo/Redo 
• Try using Undo once, and then Redo.  

5.5 Moving, Copying and Pasting Text 
You can move text to another place. A simple method of moving text is to 
store it temporarily on what is known as the clipboard, and then retrieve it 
again when you have found the place where you want to put it.  You can use 
buttons on the standard toolbar to do this. 
 

Exercise 10 Copying text 
• In the line beginning ‘Buddleia’ select the word peacocks.  
• Click on the copy button on the tool bar (or press Ctrl + C). You can use 

Hover Help ( Exercise 7) to locate tool bar buttons. 
• Position the cursor at the end of the phrase ‘Golden Rod for’. Click on the 

paste button or press Ctrl + V. 
 
If you want to move text then you use the cut button (or Ctrl + X) instead of 
the copy button (or Ctrl + C). Then you paste it to its new position. 
 

6 Saving your Document 
What we do next requires some explanation.   
 
Although you can see what you type on the screen, this text is only held 
temporarily on the computer, in its memory.  When you logout or the machine 
is switched off, everything in memory is cleared, so it is very important to save 
what you type in a permanent file!  Files are named blocks of information 
stored together on a computer or external digital storage medium (such as a 
floppy disk).  A file may be a program, a document, a database, or some other 
collection of data.  Each word-processed document is stored in its own file, 
and each file must have a name to identify it, which you invent.  Examples of 
filenames are fred.doc, poverty.doc, chapter1.doc, wnrt3.doc.  All these 
filenames end in .doc, because Word expects files that have been created in 
Word to have this ending. 
 
Choose a filename that will remind you of the contents of the file, because you 
will find that your files will soon multiply, and it is surprisingly easy to forget 
what is in each file! 
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Let us save all the text that you have typed - known as your document - in a 
file.  We must first, however, check where this file is going to be located, since 
there are different drives where it could be saved.  One option is to save the 
file on your machine, on what is known as the hard disk, or C drive.  This is 
inadvisable on CCS student workstations, however, for three reasons:  
 

 You would always have to use this machine whenever you wanted to 
access your files 

 Anyone could access your files 
 Files on the C drive on student workstations are regularly deleted by CCS 

staff 
 
It is much better to save the file on the N drive, or network drive.  This is 
actually located on a different machine on the CCS network, which means that 
you can access it from any workstation in the CCS workstation rooms.  You 
can only access that part of the N drive which has been allocated to your 
username - no-one else can get at your files, or even see them (unless, of 
course, they know your password and can therefore logon as you).  In this 
document and elsewhere, when we refer to your N drive, we mean ‘that part 
of the N drive which has been allocated to your username’. 
 

Exercise 11 Saving a file to your network drive 
• Click on File on the menu bar  (or press Alt + F) 
• Click on Save As on the File menu (or press A).  A Save As dialogue box 

appears (Figure 6-1 Save As Dialogue Box).  The folder should be My 
Documents.  If it is not then ask for help. Note that the diagram shows the 
files on my N:\My Documents folder. Yours will be different. 

• Microsoft Word for Windows 2003 has given the file a name already by 
picking the first few words of the document; i.e. with flowers.doc. 
However, it is not usually a good idea to keep this name.  For example, if 
you write many documents beginning with dear Fred, when you write a 
new letter to Fred Microsoft Word for Windows 2003 will overwrite the old 
one.  Replace with flowers.doc with garden.doc. You edit text in 
dialogue boxes in the same way that you edit the text in the main 
document; you select it and type over it. 

• Click on Save. 
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Figure 6-1 Save As Dialogue Box 
 
 
 
 

 

1. Check 
the folder 

2. Enter 
the file 
name 

3. Click on 
Save 

 
 
 
 
 
 
 
 
In section 7 we will look at a safe method of making a backup copy of your 
document on a floppy disk. In order to do this you need to close garden.doc, 
although you do not need to exit from Microsoft Word for Windows 2003.  
When you have backed up your document we will come back to Microsoft 
Word for Windows 2003 and look at some more features.  In the next exercise 
we will practice using shortcut keys.  We will see later that there are 
alternative ways of opening and closing windows. 
 

Exercise 12 Preparing to make a backup 

• Press Alt+F, C. That is holding down Alt and F keys together to open the 
file menu. Then type C to close the current document. 

• Press Alt+ space, N to minimise the Microsoft Word for Windows 2003 
window  
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7 Backing up to floppy disk 
You may want to take files and documents away to work on them on another 
PC.  A common problem seen at Help Desk, both here at Birkbeck and at 
other Universities, is corrupted floppy disks. Many of the problems are caused 
if you save your document on a floppy disk. We recommend that you always 
save your work on your network drive (N: on student PC's) and copy your files 
to and from floppy disk using a file management program called Windows 
Explorer.  As well as greatly reducing the risk of corrupting your files, you will 
normally find that working on a networked drive is faster.  Although it may 
seem tedious to do this rather than saving straight to the floppy disk, it is a lot 
less tedious than having to retype the whole essay because your disk is 
corrupt! 
 

Exercise 13 Copying to a floppy disk 
 
• Start Windows Explorer.   

Either 
o Double-click on the shortcut to start the program (see 

right). . If you find double-clicking difficult then you can 
click once on the icon to select it and then press the 
Enter key.  

or 
o Press the TAB key until one of the desktop icons is highlighted. 

Then use the cursor keys (on the bottom left side of the 
QWERTY keyboard) to move between the icons. 

• If you have not yet inserted your floppy disk into the drive please do so 
now.  If you are not sure how to do this ask the instructor for help (or go to 
CCS Help Desk). 

• If you cannot see a list of drives displayed below the My Computer icon in 
the left pane display them by clicking on the + sign. The left side of your 
window should look like Figure 7-1 Floppy Disk Drive (see next page).  

 
As we have already noted in section 6, the computer stores your work in files 
on drives. You can further organise your work into folders. Some folders, such 
as the My Documents folder have been created for you. You can use 
Windows Explorer to create your own folders using the File menu.   
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Figure 7-1 Floppy Disk Drive 
 

 
 
 
• Click on the floppy disk icon in the left hand window 
• Check that there is enough free disk space on your floppy disk. Windows 

displays the amount of free disk space at the bottom of the window 
• Double click on the My Documents folder in the left pane to display the 

contents of your My Documents folder in the right pane.  The right pane 
should contain any files that you have saved 

• In the right pane, click on garden.doc.  Windows will display the file type 
and size at the bottom of the Explorer window 

• Without moving the mouse from the selected object right click (i.e. click the 
right mouse button).  A pop up menu will appear 

• Click on Send to on the menu, then click on 3.5 inch Floppy.  Your file 
will be copied to the floppy disk.  You will notice that the floppy disk light 
comes on 

 
 
Make sure that the light on the floppy disk drive is not active before you 
remove the disk from the drive. 
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Exercise 14 Recovering a file from a floppy disk 
• Click on the floppy disk icon in the left hand window 
• In the right pane, click on garden.doc. Windows will display the file type 

and size at the bottom of the Explorer window. 
• Without moving the mouse from the selected object right click (i.e. click the 

right mouse button). A pop up menu will appear.  
• Click on Send to on the menu, then click on My Documents. If a file with 

the same name already exists you will be asked if you want to overwrite it. 
Check the creation date to see that you are not overwriting a newer 
version with an older one. If you are sure that you want to replace the 
document click on Yes 

 
 

8 Opening and Closing Documents 

8.1 Exiting from Word 
If you have finished using Microsoft Word you can close the program by 
clicking on the Close window button  (Figure 8-1) in the top right hand 
corner of the screen. This will close the currently open document. If you have 
not saved it, you will be prompted to do so. If you prefer to use the keyboard 
then press Alt + F, X.  
 

Figure 8-1 Close buttons 
 

 

Close window 
button 

Close document 
button 

 
 
 

8.2 Close a document 
If you have completed one document and you need to work on another you 
can close the current document by clicking on the close document button 
(Figure 8-1). It is located beneath the Close Window button in the top right 
corner of the screen. To use the keyboard press Alt + F, C 

8.3 Starting a new document 
To open a new blank document click on the New Blank Document button on 
the left of the tool bar. You can Hover Help ( Exercise 7) to locate it. To use 
the keyboard press Alt + F, N 
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8.4 Opening an existing document 
Microsoft Word for Windows 2003 offers several alternative methods for 
opening an existing document, i.e. 

 Click on the Open button on the left end of the toolbar. You can use hover 
help to locate it 

or 
 Press Alt + F, O.  on the keyboard 

or 
 Choose Open from the File menu. 

 
This will open a dialogue box very similar to the Save As box.  On CCS 
workstations you should see the My Documents folder.  A list of the files that 
your folder contains will appear.  Microsoft Word for Windows 2003  offers 
various options for choosing the file that you want, i.e. 

 You can type the name of the file in the filename box and then press the 
ENTER key 

 or  
 You can click on the file name to select it and then click on the open 

button 
or 

 You can double click on the filename. 
 

Exercise 15 Open garden.doc 
• Use one of the methods described above to open garden.doc 
• Position the cursor at the end of the document and type ‘My favourite 

flower is the dandelion’ 
• Save your file 

8.5 Working with more than one document 
You can have more than one document open at once. This is useful if you 
want to copy text from one document to another. With your current document 
still open, either open another document or start a new one. You can move 
between documents either by clicking on the document icon on the taskbar, or 
by pressing Alt + Tab to cycle between windows. 
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9 Spell Checking your document. 
Microsoft Word for Windows 2003 has a spell checker and a grammar 
checker. The spell checker is very useful.  The grammar checker is less 
useful, as it discourages the formal passive tense style commonly used in 
academic work.  When you spell check and grammar check your document 
you may wish to ignore Word’s advice. 
 

Exercise 16 Check your spelling 
• If you are using the mouse use hover help to locate the Spelling and 

Grammar button on the toolbar. 
• If you prefer to use the keyboard press ALT + T, S 
• The spell check window appears. You can choose to  

o Ignore the suggestion (ALT + I) 
o Ignore Rule (ALT + G) 
o Next Sentence (ALT + X) 
o Change (ALT + C) 
o You can switch off check grammar either by clearing the check box 

or by pressing ALT + K. To turn it on again either click in the box 
again to check it or press ALT + K again. This kind of on/off switch 
is sometimes referred to as a toggle switch (like an electric light 
switch) 

• When the spell check is complete Microsoft Word for Windows 2003 will 
display a message to tell you so. Either click on OK or press the Enter key 
to dismiss the message.  

• Save your document again and close it 

10 Finding out More 
The best way to find out more is to practice and experiment. Here is a list of 
alternative training material. All the documents are available from CCS help 
desk or from the CCS Web page at http://www.bbk.ac.uk/ccs  
 
1. CCS Document 3.38 ‘Getting Started on CCS Workstations’ explains how 

to use on-line Help. Microsoft Word for Windows 2003 online help provides 
step-by-step instructions on how to perform tasks. 

2. CCS Document 5.97 ‘Word-processing tips for students’  - some additional 
topics not always found in commercial textbooks on Microsoft Word for 
Windows 2003.  Topics include footnotes & endnotes and using foreign 
keyboards. 

3. ‘Software made Simple Guide to Microsoft Word for Windows 2003’ – a 
good basic introduction to Microsoft Word for Windows 2003. Note that this 
is licensed material and you will need to enter your CCS username and 
password to access from outside the College. 

4. Electric Paper Computer based training material. This is available from 
CCS workstation rooms. The user guide is CCS Document 3.39 ‘User 
Guide for Electric Paper training material’ 

5. CCS Document 5.71 ‘Using Accutype Typing tutor’ explains how to use the 
typing tutor on CCS workstations. 
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Appendix A. Using The Mouse 
To start and control programs you need to use the mouse, which is the hand-
sized object on the desk near the right of your keyboard.  
 
• Hold the mouse flat on the desk with the two buttons pointing away from you 

(see illustration).  Leave some space around it so you can move it.   
 
 
 
Notice that the index finger in the picture is on 
the left mouse button - the right button is less 
often used.   
 
 

• Move the mouse around on the desk and you will see an arrow on the screen 
moving .  This arrow is the mouse pointer.  

• Lift the mouse off the desk and move it around in the air - the mouse 
pointer on the screen does not move! 

• Return the mouse to the desk, and move it until the mouse pointer is on 
one of the icons at the left of the screen.  This is known as pointing.  If the 
mouse runs out of desk space before the pointer reaches the object that you 
are trying to select, you can lift the mouse up and move it to another spot on 
the desk. 

• When you have pointed at an icon, press and release the left mouse button 
lightly and quickly.  This is known as clicking.  The icon will change colour, 
indicating that it has been selected (but this does not as yet make the 
program start!). 

• Try selecting another icon. 
• Point and click (using the left mouse button) on the Start button at the 

bottom left of the screen.  The Start menu will be displayed. 
• Point and click (with same button) anywhere else on the screen – the Start 

menu will disappear. 
 
In these notes (as elsewhere), when you are told to click, it means point and 
click the left mouse button.  When you occasionally need to use the right 
mouse button, the notes will say click the right mouse button or right click. 
 
Using the mouse is the trickiest aspect of using Windows, so do not worry if 
you feel ham-fisted to start with! There are alternative ways of doing most 
tasks, but I suggest that you persevere with the mouse for the duration of this 
workshop, and then explore alternative methods later.  
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Appendix B. The PC Keyboard 
 

 
 

 
The numeric keypad at the right of the keyboard has been omitted from this 
diagram, since it is not normally required. Keys which have important 
functions, or whose function is unclear, are shown in grey on the diagram.  
The most important of these are described below: 
 
↵ The ENTER key (sometimes known as RETURN) is often used to cause a 

task to be carried out.  Use the key with a left-turning arrow depicted on 
it, not the key on the far right (on the numeric keypad) that actually has 
the word Enter on it - this unfortunately does not always produce the 
same effects!  

 
← Use the BACKSPACE key to erase the previous character, and the DELETE 

key (next to the ENTER key) to erase the current character. 
 
⇑  The SHIFT key (there are two on the keyboard) is used in combination 

with another character to cause a special effect.  For example, if it is held 
down while an alphabetic key is pressed, it causes the letter to be 
capitalised. 

 The CTRL (control) and ALT keys also cause special effects when used in 
combination with other keys. 

 
CAPS Pressing this key causes the CAPS LOCK light at the top right of the 

keyboard (above the numeric keypad) to light up, and capitalises all 
alphabetic characters until the key is pressed again. 

 
Esc The ESCAPE key can often be used to cancel a task.  
 
The HOME, END, PageUp and PageDown keys are all used for moving around – 
more details are given in the on-line Help for keyboard short cuts. The 
function keys at the top of the keyboard (F1, F2 etc.) are rarely used in 
Windows programs. 
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